Executive summary
Intel Corporation (Intel) commissioned Principled Technologies (PT) to compare the performance on Microsoft Windows Vista of an Intel vPro technology based PC with that of three other platforms on common predictive modeling and business intelligence scenarios. We tested two scenarios that involve Microsoft Office Excel 2007 and a third that uses Intuit QuickBooks Pro 2006. We compared the performance of the following four platforms on these scenarios:

- Intel Core 2 Duo processor E6700 on an Intel vPro 965 (DQ965GF) motherboard
- Intel Pentium D processor 930 on an Intel D945GTP motherboard
- Intel Pentium 4 processor 630 on an Intel D945GTP motherboard
- Intel Pentium 4 processor 2.8 GHz on an Intel D865GBF motherboard

As Figure 1 shows, the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 significantly outperformed the other PCs in all three scenarios. The Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 was from 1.91 times to 3.12 times faster on different tasks than the Intel Pentium D processor 930 based PC and averaged 2.53 times faster across all the tasks. (In all comparisons in which we cite the average of task times, we use the geometric mean of the normalized times for each task.)

The Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 was from 2.47 to 4.68 times faster on our tests and averaged 3.34 times faster than the PC with the Intel Pentium 4 processor 2.8GHz on the Intel D865GBF motherboard.

These performance improvements translated into multi-second time savings noticeable to users.

Figure 1: Normalized results for the test systems on all three scenarios. Larger numbers indicate better performance.
For example, the longest task took 77.34 seconds on the Intel Pentium D processor 930 based PC but only 28.55 seconds—almost 49 seconds faster—on the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700.

So that we could make the test systems as similar as reasonably possible while varying the processors and motherboards, we built the systems rather than purchasing them from vendors. Intel specified the general system types. We purchased the processors and motherboards as well as such common components as RAM, hard disks, and optical drives. Each test system had the following basic components (see Appendix A for detailed configuration information):

- 1GB of the fastest RAM its motherboard supported
- 80GB hard disk with an 8MB buffer (SATA unless the motherboard did not support it)
- DVD-RW optical drive
- Microsoft Windows Vista Ultimate

We used the following common business intelligence based applications, which we list in alphabetical order:

- Intuit QuickBooks Pro 2006
- Microsoft Office Excel 2007

The application scenarios we tested included such common functions as:

- Opening files
- Recalculating Excel spreadsheets

In the following sections we look more closely at our test application scenarios (Application scenarios), examine the results of our tests (Test results and analysis), and give detailed information about how we actually performed the tests (Test methodology). In the appendices, we present the configurations of the test systems and explain how to manually execute the application functions in our scenarios.

### Application scenarios

We chose scenarios that involve common predictive modeling and business intelligence tasks and applications. In two of our scenarios we used Microsoft Office Excel 2007. The multithreaded design of this new version of Excel paid dividends in user performance on the Intel vPro technology based system. The third scenario uses Intuit QuickBooks Pro 2006, an application common in small and medium businesses.

#### Recalculating business revenue using Microsoft Office Excel 2007

Brian Corcoran is a forensic accountant investigating a failed business that is the plaintiff in a shareholder class-action suit. He is examining the original spreadsheet the business used to estimate revenues over five years of its telecommunications services. The spreadsheet calculates revenues based on the number of T1 trunks and customers and the penetration of voice, call management, and multimedia services. Brian recalculates the Excel spreadsheet to see how the various models it employs compare to the actual revenues of the company.

We timed:

- the Microsoft Excel 2007 calculation from when Brian presses F9 in Excel to start the recalculation until the recalculation percentage indicator reached 100 percent and closed

#### Running a Monte Carlo simulation in Microsoft Office Excel 2007

Jordan Michaels, a GMC auto dealer, believes that demand for new Envoys will be normally distributed with a mean of 200 and standard deviation of 30. His cost of receiving an Envoy is $25,000, and he sells an Envoy for $40,000. He can sell half of all the leftover Envoys for $30,000. He is trying to decide how many Envoys to order, so he builds a spreadsheet with models of orders of 200, 220, 240, 260, 280, and 300 Envoys. Jordan is able to calculate the number of Envoys he should order for his dealership by using a Monte Carlo simulation that runs on Microsoft Office Excel 2007.
To take advantage of publicly available data, we started with a Monte Carlo spreadsheet from Microsoft's Web site. (Adapted from Winston, W.L. (2004): *Microsoft® Excel®: Data Analysis and Business Modeling.* Washington: Microsoft Press, p. 462.) To make this initial spreadsheet more like one a real business might use, we added additional worksheets for each quantity of vehicles--200, 220, 240, 260, 280, and 300--that the dealer is considering purchasing.

We timed:

- the Microsoft Excel 2007 calculation from when Jordan presses F9 in Excel to start the recalculation until the Data Table indicator on the Status Bar goes away

**Viewing a set of memorized reports in Intuit QuickBooks Pro 2006**

Mark Owens is in charge of examining the books of a company, Rock Castle Construction, that his firm is interested in acquiring. He instructs his accountant to go through Rock Castle Construction's Intuit QuickBooks data file and prepare multiple memorized reports for him to review. When Mark receives the QuickBooks file from his accountant, he loads the file onto his system. He then opens the set of memorized reports to view Rock Castle’s overall performance since its inception.

We timed:

- the appearance of the Intuit QuickBooks Pro 2006 reports from when Mark clicks Display until all the report windows are open

For more details on how we executed and measured these scenarios, our specific test functions, and the files the scenarios use, see Appendix B.

**Test results and analysis**

In this section we examine the results of each of our tests. Figure 2 shows the times, in seconds, that each test system needed to complete each scenario. The times we show for each platform for each scenario are from the median run of the five test runs of that scenario on that platform.

<table>
<thead>
<tr>
<th>Tests</th>
<th>Intel Pentium 4 processor 2.8 GHz on Intel D865GBF</th>
<th>Intel Pentium 4 processor 630 on Intel D945GTP</th>
<th>Intel Pentium D processor 930 on Intel D945GTP</th>
<th>Intel vPro with Core 2 Duo processor E6700 on Intel DQ965GF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excel recalculation scenario</td>
<td>133.56</td>
<td>116.10</td>
<td>77.34</td>
<td>28.55</td>
</tr>
<tr>
<td>Monte Carlo simulation</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Running a Monte Carlo simulation in Microsoft Excel 2007</td>
<td>10.26</td>
<td>10.11</td>
<td>7.94</td>
<td>4.15</td>
</tr>
<tr>
<td>Intuit QuickBooks scenario</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Viewing a set of reports in Intuit QuickBooks Pro 2006</td>
<td>10.26</td>
<td>10.11</td>
<td>7.94</td>
<td>4.15</td>
</tr>
</tbody>
</table>

*Figure 2: Median test times, in seconds, for all test systems on all three scenarios. Lower numbers are better.*

In the following sub-sections we explore these results in more detail. To make comparisons easier, we always show results normalized to those of the slowest system in the group, the Intel Pentium 4 processor 2.8GHz based PC with the Intel D865GBF motherboard. To compute those normalized results, we divided each system’s time by the time it took the slowest system. The result for the Intel Pentium 4 processor 2.8GHz based PC with the Intel D865GBF motherboard is thus always 1.00, because it’s the comparison basis. Results higher than 1.00 indicate how much faster a system is than that system. Because of the normalization, higher result numbers are better. For example, a result of 1.80 would mean the system in question was 80 percent faster than the Intel Pentium 4 processor 2.8GHz based PC.
Recalculating business revenue using Microsoft Office Excel 2007
As Figures 3 and 4 show, the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 was 2.71 times faster than the Intel Pentium D processor 930 based PC on this test. Additionally, the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 was 4.68 times faster than the PC with the Intel Pentium 4 processor 2.8GHz and the Intel D865GBF motherboard.

As Figure 4 shows, these differences represent significant improvements in the time it takes to perform each task. Compared to the Intel Pentium D processor 930 based PC, the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 decreased the elapsed time from 77.34 to 28.55 seconds. Compared to the PC with the Intel Pentium 4 processor 2.8GHz on the Intel D865GBF motherboard, the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 decreased the elapsed time from 133.58 to 28.55 seconds--a savings of over a hundred seconds.

Intel Core 2 Duo processor E6700 decreased the elapsed time from 133.58 to 28.55 seconds--a savings of over a hundred seconds.

<table>
<thead>
<tr>
<th>PERFORMANCE RESULTS (seconds)</th>
<th>COMPARATIVE RATING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intel Pentium 4 processor 2.8 GHz on Intel D865GBF</td>
<td>Intel Pentium 4 processor 2.8 GHz on Intel D865GBF</td>
</tr>
<tr>
<td>Intel Pentium 4 processor 630 on Intel D945GTP</td>
<td>Intel Pentium 4 processor 630 on Intel D945GTP</td>
</tr>
<tr>
<td>Intel Pentium D processor 930 on Intel D945GTP</td>
<td>Intel Pentium D processor 930 on Intel D945GTP</td>
</tr>
<tr>
<td>Intel vPro with Core 2 Duo processor E6700 on Intel DQ965GF</td>
<td>Intel vPro with Core 2 Duo processor E6700 on Intel DQ965GF</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TASKS</th>
<th>PERFORMANCE RESULTS (seconds)</th>
<th>COMPARATIVE RATING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task: Recalculating business revenue</td>
<td>133.56</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td>116.10</td>
<td>1.15</td>
</tr>
<tr>
<td></td>
<td>77.34</td>
<td>1.73</td>
</tr>
<tr>
<td></td>
<td>28.55</td>
<td>4.68</td>
</tr>
</tbody>
</table>

Figure 3: Normalized results for the Excel recalculation scenario for all test systems. Larger numbers indicate better performance.

Figure 4: Results for the Excel recalculation scenario for all test systems. Lower performance results are better. Higher comparative ratings are better.
Running a Monte Carlo simulation in Microsoft Office Excel 2007

Figures 5 and 6 illustrate the results of this test. The Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 was 3.12 times faster than the Intel Pentium D processor 930 based PC. Additionally, the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 was 3.22 times faster than the PC with the Intel Pentium 4 processor 2.8GHz on the Intel D865GBF motherboard.

As Figure 6 shows, these differences represent significant improvements in the time it takes to perform each task. Compared to the Intel Pentium D processor 930 based PC, the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 decreased the elapsed time from 14.92 to 4.63 seconds. Compared to the PC with the Intel Pentium 4 processor 2.8GHz on the Intel D865GBF motherboard, the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 decreased the elapsed time from 14.92 to 4.63 seconds.

![Monte Carlo simulation](image)

Figure 5: Normalized results for the Monte Carlo simulation for all test systems. Larger numbers indicate better performance.

<table>
<thead>
<tr>
<th>PERFORMANCE RESULTS (seconds)</th>
<th>COMPARATIVE RATING</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>TASKS</strong></td>
<td>Intel Pentium 4 processor 2.8 GHz on Intel D865GBF</td>
</tr>
<tr>
<td>Intel Pentium 4 processor 2.8 GHz on Intel D865GBF</td>
<td>14.92</td>
</tr>
</tbody>
</table>

Figure 6: Results for the Monte Carlo simulation for all test systems. Lower performance results are better. Higher comparative ratings are better.
Principled Technologies, Inc.: System performance in predictive modeling and business intelligence scenarios on Microsoft Windows Vista

Viewing data in Intuit QuickBooks Pro 2006

As Figures 7 and 8 show, the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 was 1.91 times faster than the Intel Pentium D processor 930 based PC on this test. Additionally, Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 was 2.47 times faster than the PC with the Intel Pentium 4 processor 2.8GHz on the Intel D865GBF motherboard.

Figure 8 shows that these differences represent significant improvements in the time a user would need to perform each task. Compared to the Intel Pentium D processor 930 based PC, the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 decreased the elapsed time from 7.94 to 4.15 seconds. Compared to the PC with the Intel Pentium 4 processor 630, Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 decreased the elapsed time from 10.11 to 4.15 seconds on the task.

<table>
<thead>
<tr>
<th>PERFORMANCE RESULTS (seconds)</th>
<th>COMPARATIVE RATING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intel Pentium 4 processor 2.8 GHz on Intel D865GBF</td>
<td>10.26</td>
</tr>
<tr>
<td>Intel Pentium 4 processor 630 on Intel D945GTP</td>
<td>10.11</td>
</tr>
<tr>
<td>Intel Pentium D processor 930 on Intel D945GTP</td>
<td>7.94</td>
</tr>
<tr>
<td>Intel vPro with Core 2 Duo processor E6700 on Intel DQ965GF</td>
<td>4.15</td>
</tr>
</tbody>
</table>

Task: Viewing memorized reports in QuickBooks

Figure 7: Normalized results for the Intuit QuickBooks scenario for all test systems. Larger numbers indicate better performance.

Figure 8: Results for the Intuit QuickBooks scenario for all test systems. Lower performance results are better. Higher comparative ratings are better.
Test methodology

Setting up the test systems
To get the most accurate and repeatable results possible, start with a clean hard disk and set up all the test systems using the following procedures.

Installing Microsoft Windows Vista Ultimate
Use the following process to install a clean version of Windows Vista Ultimate on each system under test:

1. Install Windows Vista Ultimate Build 6000.
   a. Boot to a Windows Vista Ultimate Build 6000 DVD.
   b. When prompted, press any key to boot from the DVD.
   c. At the language and preference screen, accept the default options, and click Next.
   d. Click Install now.
   e. Do not enter a Product key. Uncheck Automatically activate Windows when I’m online, and click Next.
   f. At the Do you want to enter your product key now screen, click No.
   g. Select Windows Vista Ultimate, and check I have selected the edition of Windows that I purchased.
   h. Click Next.
   i. Check I accept the license terms.
   j. Click Next.
   k. At the Which type of installation do you want screen, select Custom (advanced).
   l. Click Drive options (advanced).
   m. Select the destination Disk for the operating system.
   n. Click Format.
   o. Click OK at the all data stored will be permanently deleted dialog.
   p. Once the system finishes formatting the disk, click Next.
   q. Fill in the Username and Password fields, and click Next.
   r. Fill in the computer name field, and click Next.
   s. When the system presents the option to enable Automatic Updates, click Ask me later.
   t. Select the correct time zone, date, and time, and click Next.
   u. At the Select your computer’s current location screen, click Public location.
   v. Click Start at the Thank you screen.
   w. When the Windows Vista Ultimate installation completes, close the Welcome Center Dialog.
   x. At the Set network location screen, click Public location.
   y. Click Close.

2. Set the test resolution.
   a. Right-click on the desktop.
   b. Select Personalize.
   c. Click Display Settings.
   d. If the monitor resolution is not already 1280 by 1024, adjust it to that setting.
   e. Click OK.

3. Verify that Windows Automatic Updates are off.
   a. Click Start.
   b. Select Control Panel.
   c. Click Security.
   d. Under Security Center, select Turn automatic updating off.
   e. Select the Never check for updates radio button.
   f. Click OK.

4. Turn off System Restore. Doing so prevents such events from occurring during testing and affecting results.
   a. Click Start.
   b. Right-click Computer.
   c. Select Properties.
   d. Select System protection on the left.
   e. Click Continue.
6. Add the system to the test domain.
   a. Click Start.
   b. Right-click Computer.
   c. Select Properties.
   d. Select Change settings.
   e. Click Continue.
   f. Click Change.
   g. Select the Domain radio button.
   h. Type the test domain name.
   i. Click OK.
   j. Type the administrator credentials in the User name and Password fields.
   k. Click OK.
   l. Click OK at the Computer Name/Domain Changes dialog box.
   m. Click OK again.
   n. Close the System Properties window.
   o. Close all other open windows before clicking Restart Now.
   p. Log in.
   q. Uncheck the Run at startup box on the Welcome Center before closing it.

7. Add the user to the Administrators group.
   a. Click Start.
   b. Right-click Computer.
   c. Select Manage.
   d. Click Continue.
   e. Select Local Users and Groups on the left.
   f. Double-click Groups in the center.
   g. Select Administrators.
   h. Click Add…, and type the domain test user account.
   i. Click OK.
   j. Type the administrator credentials in the User name and Password fields.
   k. Click Apply.
   l. Click OK.
   m. Close all windows.
   n. Click Start.
   o. Click the arrow. 
   p. Select Log Off.
   q. Press Ctrl + Alt + Delete at the prompt.
   r. Click Switch User, and select Other User.
   s. Type the test user’s credential in the User name and Password fields.
   t. Press Enter.

8. Turn all Power Management settings to Performance.
   a. Click Start.
   b. Select Control Panel.
   c. Select Appearance and Personalization.
   d. Under Personalization, click Change screen saver.
   e. Select (None) from the Screen saver drop-down menu.
   f. Click the Change power settings link.
   g. Click the High performance radio button.
   h. Select Never for the Turn off the display and Put the computer to sleep drop-down menus.
   i. Click Change advanced power settings.
   j. Click Hard disk → Turn off hard disk after → Setting (Minutes), then type Never.
   k. Scroll down, and click Sleep → Sleep after → Setting (Minutes), and type Never.
   l. Click Sleep → Allow Hybrid Sleep → Setting.

Principled Technologies, Inc.: System performance in predictive modeling and business intelligence scenarios on Microsoft Windows Vista
m. Select Off.
n. Scroll down, and click Display→Turn off display after→Setting, then type Never.
o. Click OK.
p. Click Save changes.
q. Close the Power Options window.
r. Click OK on the Screen Saver Settings.

Installing Adobe Flash Player 9.0
Use the following process to install a clean version of Adobe Flash Player 9:

a. Uncheck the box next to YAHOO! toolbar, and click Install Now.
b. Click Continue at the User Account Control dialog.
c. Click Install at the Security Warning dialog.
d. Flash Player is successfully installed when the flash installation completion movie plays.

Installing Intuit QuickBooks Pro 2006
Use the following process to install a clean version of Intuit QuickBooks Pro 2006. This installation includes an automatic installation of the Microsoft .NET 1.1 Runtime.

Note: We occasionally received the following message near the end of the Intuit QuickBooks install: “Error 1904. Module C:\QB.ocx failed to register”. We clicked Ignore to bypass this error.

1. Insert the Intuit QuickBooks Pro 2006 installation CD.
a. Click Run setup.exe.
b. Click Allow at the User Account Control screen.
c. Click Run program at the Program Compatibility Assistant screen.
d. Click Install at the welcome screen.
e. Click Next at the .NET 1.1 Runtime installation screen.
f. Click Next at the Welcome to QuickBooks Installation Wizard screen.
g. Select Accept, and click Next at the License Agreement screen.
h. Enter the Intuit QuickBooks License Number and Product Number, and click Next.
i. Accept the default installation path, and click Next.
j. Click Install at the Ready to install QuickBooks screen.
k. Click Finish at the installation complete screen.
l. Click OK at the QuickBooks has completed verifying configuration dialog.

2. After installation of Intuit QuickBooks Pro 2006 completes, configure the application for testing by following these steps once:
a. Launch the application by double-clicking the QuickBooks Pro 2006 desktop shortcut.
b. Click File→Open Company.
c. Select sample_product based_business.qbw, and click Open.
d. Click OK at the QuickBooks Information dialog.

3. At the QuickBooks Learning Center screen, uncheck Show this window at startup, and close the Welcome screen.

4. Turn off automatic updates by following these steps once:
a. Click Help→Update QuickBooks→Options.
b. Select No to Automatic Update.
c. Click Save.
d. Close the Update dialog.

5. Close all open windows.
8. Verify that a single window with the title No Company Open appears.
**Installing Microsoft Office Enterprise 2007**

Use the following process to install a clean version of Microsoft Office 2007 Enterprise on both the Windows Vista and Windows XP operating system images for each system:

1. Insert the Microsoft Office Enterprise 2007 DVD.
2. Select Run SETUP.EXE.
3. Click Continue at the User Account Control dialog.
4. Click Install Now.
5. Click Close at the Microsoft Office Enterprise 2007 has been successfully installed screen.
## Appendix A – Test system configuration information

This appendix provides detailed configuration information about each of the test systems.

<table>
<thead>
<tr>
<th>System processor and motherboard</th>
<th>Intel vPro with Intel Core 2 Duo processor E6700 (2.66 GHz Dual-Core) on Intel DQ965GF motherboard</th>
<th>Intel Pentium D processor 930 (3.0 GHz Dual-Core) on Intel D945GTP motherboard</th>
<th>Intel Pentium 4 processor 630 (3.0 GHz) on Intel D945GTP motherboard</th>
<th>Intel Pentium 4 processor (2.8 GHz) on Intel D865GBF motherboard</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Processor and OS kernel: (physical, core, logical) / (UP, MP)</td>
<td>1P2C2L / MP</td>
<td>1P2C2L / MP</td>
<td>1P1C2L / MP</td>
<td>1P1C1L / UP</td>
</tr>
<tr>
<td>Number of physical processors</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Single/Dual-Core processors</td>
<td>Dual</td>
<td>Dual</td>
<td>Single</td>
<td>Single</td>
</tr>
<tr>
<td>Processor HT status</td>
<td>NA</td>
<td>NA</td>
<td>Enabled</td>
<td>NA</td>
</tr>
<tr>
<td>System Power Management Policy</td>
<td>High Performance</td>
<td>High Performance</td>
<td>High Performance</td>
<td>High Performance</td>
</tr>
<tr>
<td><strong>CPU</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor</td>
<td>Intel</td>
<td>Intel</td>
<td>Intel</td>
<td>Intel</td>
</tr>
<tr>
<td>Name</td>
<td>Core 2 Duo</td>
<td>Pentium D</td>
<td>Pentium 4</td>
<td>Pentium 4</td>
</tr>
<tr>
<td>Model Number</td>
<td>E6700</td>
<td>930</td>
<td>630</td>
<td>NA</td>
</tr>
<tr>
<td>Stepping</td>
<td>6</td>
<td>2</td>
<td>3</td>
<td>7</td>
</tr>
<tr>
<td>Socket type</td>
<td>LGA775</td>
<td>LGA775</td>
<td>LGA775</td>
<td>Socket 478</td>
</tr>
<tr>
<td>Core frequency (GHz)</td>
<td>2.66</td>
<td>3.0</td>
<td>3.0</td>
<td>2.8</td>
</tr>
<tr>
<td>Front-side bus frequency</td>
<td>1066 MHz</td>
<td>800 MHz</td>
<td>800</td>
<td>533 MHz</td>
</tr>
<tr>
<td>L1 Cache</td>
<td>32 KB + 32 KB (per core)</td>
<td>16 KB + 12 Kµops (per core)</td>
<td>16 KB + 12 Kµops</td>
<td>8 KB + 12 Kµops</td>
</tr>
<tr>
<td>L2 Cache</td>
<td>4 MB (shared)</td>
<td>4 MB (2 MB per core)</td>
<td>2 MB</td>
<td>512 KB</td>
</tr>
<tr>
<td><strong>Platform</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor</td>
<td>Intel</td>
<td>Intel</td>
<td>Intel</td>
<td>Intel</td>
</tr>
<tr>
<td>Motherboard model number</td>
<td>DQ965GF</td>
<td>D945GTP</td>
<td>D945GTP</td>
<td>D865GBF</td>
</tr>
<tr>
<td>Motherboard chipset</td>
<td>Intel Q965</td>
<td>Intel i945G</td>
<td>Intel i945G</td>
<td>Intel i865G</td>
</tr>
<tr>
<td>Motherboard revision number</td>
<td>C1</td>
<td>A2</td>
<td>A2</td>
<td>A2</td>
</tr>
<tr>
<td>Motherboard serial number</td>
<td>BQGF63500GE9 / AAD41676-305</td>
<td>LATP61618159 / AAC97837-301</td>
<td>LATP61618114 / AAC97837-301</td>
<td>ABBF31715528 / AAC28142-401</td>
</tr>
<tr>
<td>BIOS settings</td>
<td>Setup default</td>
<td>Setup default</td>
<td>Setup default</td>
<td>Setup default</td>
</tr>
<tr>
<td><strong>Memory module(s)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Corsair CM2X512A-6400</td>
<td>Micron 8HTF6464AY-667D</td>
<td>Micron 8HTF6464AY-667D</td>
<td>Samsung M3 68L6423FTN-CCC</td>
</tr>
<tr>
<td>Type</td>
<td>PC2-6400</td>
<td>PC2-5300</td>
<td>PC2-5300</td>
<td>PC3200</td>
</tr>
<tr>
<td>Speed (MHz)</td>
<td>800</td>
<td>667</td>
<td>667</td>
<td>400</td>
</tr>
<tr>
<td>------------</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>Speed running in the system (MHz)</td>
<td>400</td>
<td>333</td>
<td>333</td>
<td>166</td>
</tr>
<tr>
<td>Timing/Latency (tCL-tRCD-tRP-tRASmin)</td>
<td>5-5-5-18</td>
<td>5-5-5-15</td>
<td>5-5-5-15</td>
<td>2.5-3-3-7</td>
</tr>
<tr>
<td>Size</td>
<td>1024 MB</td>
<td>1024 MB</td>
<td>1024 MB</td>
<td>1024 MB</td>
</tr>
<tr>
<td>Number of memory modules</td>
<td>2 x 512 MB</td>
<td>2 x 512 MB</td>
<td>2 x 512 MB</td>
<td>2 x 512 MB</td>
</tr>
<tr>
<td>Chip organization</td>
<td>Double-sided</td>
<td>Double-sided</td>
<td>Double-sided</td>
<td>Double-sided</td>
</tr>
</tbody>
</table>

**Hard disk**

<table>
<thead>
<tr>
<th>Vendor and model number</th>
<th>Seagate ST3808110AS</th>
<th>Seagate ST380811AS</th>
<th>Seagate ST380811AS</th>
<th>Seagate ST3802110A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>80 GB</td>
<td>80 GB</td>
<td>80 GB</td>
<td>80 GB</td>
</tr>
<tr>
<td>Buffer Size</td>
<td>8 MB</td>
<td>8 MB</td>
<td>8 MB</td>
<td>2 MB</td>
</tr>
<tr>
<td>RPM</td>
<td>7200</td>
<td>7200</td>
<td>7200</td>
<td>7200</td>
</tr>
<tr>
<td>Type</td>
<td>SATA 300 MB/s</td>
<td>SATA 150 MB/s</td>
<td>SATA 150 MB/s</td>
<td>ATA 100</td>
</tr>
<tr>
<td>Controller</td>
<td>Intel 82801HR (ICH8)</td>
<td>Intel 82801GB (ICH7)</td>
<td>Intel 82801GB (ICH7)</td>
<td>Intel 82801EB (ICH5)</td>
</tr>
<tr>
<td>Driver</td>
<td>Intel 6.2.0.2002</td>
<td>Microsoft 6.0.6000.16384</td>
<td>Microsoft 6.0.6000.16384</td>
<td>Microsoft 6.0.6000.16384</td>
</tr>
</tbody>
</table>

**Operating system**

<table>
<thead>
<tr>
<th>Name</th>
<th>Microsoft Windows Vista Ultimate RTM</th>
<th>Microsoft Windows Vista Ultimate RTM</th>
<th>Microsoft Windows Vista Ultimate RTM</th>
<th>Microsoft Windows Vista Ultimate RTM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build number</td>
<td>6000</td>
<td>6000</td>
<td>6000</td>
<td>6000</td>
</tr>
<tr>
<td>File system</td>
<td>NTFS</td>
<td>NTFS</td>
<td>NTFS</td>
<td>NTFS</td>
</tr>
<tr>
<td>Kernel</td>
<td>ACPI x86 based PC</td>
<td>ACPI x86 based PC</td>
<td>ACPI x86 based PC</td>
<td>ACPI x86 based PC</td>
</tr>
<tr>
<td>Language</td>
<td>English</td>
<td>English</td>
<td>English</td>
<td>English</td>
</tr>
<tr>
<td>Microsoft DirectX version</td>
<td>DirectX 10</td>
<td>DirectX 10</td>
<td>DirectX 10</td>
<td>DirectX 10</td>
</tr>
</tbody>
</table>

**Graphics**

<table>
<thead>
<tr>
<th>Vendor and model number</th>
<th>Intel GMA 3000</th>
<th>Intel GMA 950</th>
<th>Intel GMA 950</th>
<th>Intel Extreme Graphics 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Integrated</td>
<td>Integrated</td>
<td>Integrated</td>
<td>Integrated</td>
</tr>
<tr>
<td>Chipset</td>
<td>Intel Q965 Express Chipset</td>
<td>Intel 945G Express Chipset</td>
<td>Intel 945G Express Chipset</td>
<td>Intel 865G</td>
</tr>
<tr>
<td>BIOS version</td>
<td>1377</td>
<td>1256</td>
<td>1256</td>
<td>1318</td>
</tr>
<tr>
<td>Memory size</td>
<td>256 MB Shared</td>
<td>128 MB Shared</td>
<td>128 MB Shared</td>
<td>224 MB</td>
</tr>
<tr>
<td>Resolution (for single-monitor tests)</td>
<td>1280 x 1024 x 32 @ 60Hz</td>
<td>1280 x 1024 x 32 @ 60Hz</td>
<td>1280 x 1024 x 32 @ 60Hz</td>
<td>1280 x 1024 x 32 @ 60Hz</td>
</tr>
<tr>
<td>Other for dual monitor tests</td>
<td>PixelView ADD-7307-DVI-N</td>
<td>PixelView ADD-7307-DVI-N</td>
<td>PixelView ADD-7307-DVI-N</td>
<td>NA</td>
</tr>
</tbody>
</table>

**Sound card/subsystem**

<table>
<thead>
<tr>
<th>Vendor and model number</th>
<th>SigmaTel 92XX High Definition Audio</th>
<th>SigmaTel 92XX High Definition Audio</th>
<th>SigmaTel 92XX High Definition Audio</th>
<th>SoundMAX Integrated Digital Audio Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Driver</td>
<td>Microsoft 6.0.6000.16386</td>
<td>Microsoft 6.0.6000.16384</td>
<td>Microsoft 6.0.6000.16384</td>
<td>Analog Devices 5.12.1.5410</td>
</tr>
</tbody>
</table>

**Ethernet**
<table>
<thead>
<tr>
<th>Vendor and model number</th>
<th>Intel 82566DM Gigabit</th>
<th>Intel PRO/1000 PM</th>
<th>Intel PRO/1000 PM</th>
<th>Intel PRO/1000 PM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Driver</td>
<td>Intel 9.6.8.0</td>
<td>Microsoft 9.6.8.0</td>
<td>Microsoft 9.6.8.0</td>
<td>Microsoft 8.1.37.2</td>
</tr>
<tr>
<td>Optical drive(s)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>DVD-RW</td>
<td>DVD-RW</td>
<td>DVD-RW</td>
<td>DVD-RW</td>
</tr>
<tr>
<td>Dual/Single layer</td>
<td>Dual</td>
<td>Dual</td>
<td>Dual</td>
<td>Dual</td>
</tr>
<tr>
<td>USB ports</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td># of ports</td>
<td>8</td>
<td>6</td>
<td>6</td>
<td>4</td>
</tr>
<tr>
<td>Type of ports (USB1.1, USB2.0)</td>
<td>USB 2.0</td>
<td>USB 2.0</td>
<td>USB 2.0</td>
<td>USB 2.0</td>
</tr>
<tr>
<td>IEEE 1394 ports</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td># of ports</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Monitor</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Model</td>
<td>Samsung SyncMaster 997DF</td>
<td>Samsung SyncMaster 997DF</td>
<td>Samsung SyncMaster 997DF</td>
<td>Samsung SyncMaster 997DF</td>
</tr>
<tr>
<td>Screen size</td>
<td>19&quot;</td>
<td>19&quot;</td>
<td>19&quot;</td>
<td>19&quot;</td>
</tr>
</tbody>
</table>

Figure 9: Detailed system configuration information for each of the test systems.
Appendix B – Instructions for running the application scenarios

We evaluated the performance of each of the test systems on each of the application scenarios (see the Application scenarios section for more information on them) by hand-timing the tasks in those scenarios.

We collected results for five runs of each scenario in each system configuration. We refer in this paper only to the median results of those runs on each system configuration. Lower times to complete a given function indicate better performance. We round those times to hundredths of seconds in this report.

In the following instructions, we assume you have already completed all of the setup work in the Test Methodology section.

Recalculating business revenue using Microsoft Office Excel 2007

The application involved
- Microsoft Office Excel 2007

The data file involved
- Excel2minA.xls, a 447KB Excel spreadsheet

The test process

First, prepare each system by following these steps once:

1. Copy the Excel2minA.xls test file to the desktop.
3. Click the Office Button.
4. Click Excel Options.
5. Click Trust Center.
6. Click Trust Center Settings.
7. Click Macro Settings.
8. Select Enable all macros (not recommended; potentially dangerous code can run).
9. Click OK to close the Trust Center.
10. Click OK to close Excel Options.

To execute the test, follow these instructions. You will need one stopwatch.

1. Reboot the system under test.
2. Log in.
3. Wait 2.5 minutes to be sure the system has completed booting and is in a consistent starting state.
4. Double-click the Excel2minA.xls file to open it.
5. Click the Outputs tab to open the Outputs Worksheet.
6. Wait 10 seconds after opening the file.
7. Prepare the stopwatch.
8. Simultaneously press F9 and start the stopwatch.
9. Stop the stopwatch when the recalculation percentage indicator reaches 100 percent and closes.
10. Record this time as the test’s result.
11. Repeat these steps four times for a total of five runs.

We report the time, in seconds, that Microsoft Office Excel 2007 took to perform the recalculation. Lower times indicate faster performance and so are better.

Running a Monte Carlo simulation in Microsoft Office Excel 2007

The application involved
- Microsoft Office Excel 2007
The data file involved
- AutoDealer.xls, a 1.5MB Excel spreadsheet

The test process
First, prepare each system by following these steps once:

1. Copy AutoDealer.xls to the desktop.
3. Click the Office Button.
4. Click Excel Options.
5. Click Trust Center.
6. Click Trust Center Settings.
7. Click Macro Settings.
8. Select Enable all macros (not recommended; potentially dangerous code can run).
9. Click OK to close the Trust Center.
10. Click OK to close Excel Options.

To execute the test, follow these instructions. You will need one stopwatch.

1. Reboot the system under test.
2. Log in.
3. Wait 2.5 minutes to be sure the system has completed booting and is in a consistent starting state.
4. Double-click the AutoDealer.xls file to open it.
5. Wait 10 seconds after opening the file.
6. Prepare the stopwatch.
7. Simultaneously press F9 and start the stopwatch.
8. Stop the stopwatch when the Data Table indicator on the Status Bar goes away.
9. Record this time as the test’s result.
10. Repeat these steps four times for a total of five runs.

We report the time, in seconds, that Microsoft Office Excel 2007 took to perform the recalculation. Lower times indicate faster performance and so are better.

Viewing data in Intuit QuickBooks Pro 2006

The application involved
- Intuit QuickBooks Pro 2006

The data file involved
- sample_product based business.QBB, a 7,036KB sample QuickBooks data file

The test process
First, prepare each system by following these steps once to load the test QuickBooks database:

b. Click File→Restore.
c. At the Restore Company Backup dialog box, select the radio button next to Disk:, if that button is not already selected.
d. Click the Browse button.
e. Browse to the sample_product based business.QBB file, and click Open. This action returns you to the Restore Company Backup dialog box.
f. Click Restore.
g. Click Yes to confirm overwriting an existing company file.
h. Type YES in the field in the Delete Entire File dialog box, and click OK.
i. Click OK at the two subsequent QuickBooks Information dialog boxes.
To execute the test, follow these instructions. You will need one stopwatch.

1. Reboot the system under test.
2. Log in.
3. Wait 2.5 minutes to be sure the system has completed booting and is in a consistent starting state.
5. Click Open to open the company file (sample_product based business.qbw).
6. Click OK to close the QuickBooks information dialog.
7. At the Register Intuit QuickBooks Pro 2006 screen, click Remind Me Later.
8. Click WindowÆClose All to close any open windows.
9. Select Favorite Reports from the drop-down list.
10. Prepare the stopwatch.
11. Simultaneously click Display and start the stopwatch.
12. Stop the stopwatch when all the report windows are open (pay particular attention to top left report).
13. Record this time as the test’s result.
14. Click WindowÆClose All to close the reports before closing QuickBooks Pro to re-run the test.
15. Repeat these steps four times for a total of five runs.

We report the time, in seconds, that Intuit QuickBooks Pro 2006 took to load the reports. Lower times indicate faster performance and so are better.